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Visualization Using Tableau

Your supervisor has forwarded to you an Excel file and wants you to create several
visualizations. Recurring projects are usually cleaned and transformed using specialized
ETL (Extract, Transform, and Load) software such as Tableau Prep Builder, Alteryx, or
Power BI. However, this is a onetime project which contains predominantly clean data,
which you will correct in Excel. To provide an audit trail, copy the tab “Source Data” to a
new tab “Sales”.

Open the file Cuddly_Stuffed_Animals.xlsx in Excel, and select the “Source Data” sheet.

Click on the tab “Source Data”, and then press the Ctrl key. Move slightly to the right,
release the mouse, and then release the Ctrl key.
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Introduction

Introduction | Source Data | Source Data (2) | Products

Rename the “Source Data (2)” tab “Sales”.

N

Introduction Source Data | Sales | Prc
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Visualization Using Tableau

Part 1: Excel, Clean the Data

Before connecting the Excel worksheet to Tableau, any inconsistently recorded data

must be rectified. For example, there are only four valid entries
for “Salesperson”. If a spelling error or an abbreviation exists in

the data, such as “G. Washington”, it must be corrected. The
data verification can easily be accomplished by using either

Pivot Tables or Filters.

Verifying the “ Salesperson” field using a Pivot Table.

| ade

Salesperson

1302 John Adams
1302 Thomas lefferson
1304 James Madison

1301 Gecrge Washingion

Confirm that the file Cuddly_Stuffed_Animals.xlsx in Excel is open and that the “Sales”

sheet is selected.

On the Sales sheet, select any cell with data, for example, cell C7.

On the Insert tab, select “Pivot Table".
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By default, the “Table/Range” is defined based on the number of rows and columns in

the data set, and the placement for
the Pivot Table will be a “New
Worksheet”. Select “OK” for the
default options.

Create PivotTable

Choose the data that you want to analyze
(@ select a table or range
Table/Range: Sales!$A$l:$I$95|
(O Use an external data source
Choose Connection...

Connection name:
Use this workbook's Data Model
Choose where you want the PivotTable report to be placed
© Mew Worksheet
O Existing Worksheet

Choose whether you analyze multiple tables

I:‘ Add this data to the Data

Part 1: Clean the Data in Excel using a Pivot Table

?

P24

I=»

I

Cancel

A ] 0 ] £ : G H I
1 Sales Order # Salesperson # Salesperzon Title | Region |State Product # of units Sales |
k] B70a2 1301 George Washington Sales Associate | South [E=3 Stuffed Pig 430 51200000
3 7083 1302 John Adams Senior Sales Associate Morhesst VT Stuffed Horse 1344 532256 00
4 B4 1304 James Madsan Sales Associate | Mortheast MH  Stufted Panda GEd H15,732.00
3 BT0BS 1302 Johin Adams Sanlor Sales Assoclate  West AR Stuffed Pig 1.140 52850000
[ E7086 1302 John Adams Sanior Sales Associale Mortheast CT Stuffad Pig 1.224 530,800.00
7 | &7oar 1307 George Washingtan |Sales Asscciate | Mortheast MNJ  Siuffed Horse 468 511.232.00
7 B708E 1301 George Washingtan ‘Sales Associate | Naortheast ME Siuffed Bear 1548  £30.960 00

nlroduclion  Sowee Dala | Sales | Picducls Salespaison | Region ¥ 1



Visualization Using Tableau

Add “Salesperson” to the “Rows” section by selecting the field and dragging it.

Drag “Sales” to the “Values” section by selecting the field and dragging it.

PivoiTable Balds - X PivotTable Fields v X

Choose fields ta add to report d - Choose fields to add to report: &b~

Search /'w' Search ,O
) [ state -

e ] Product

e F § [ ] # of units

1}
1
State !
S -
Produtt -
1

N
1

N
1 =
Nrag Tielhls between areas o Drag fl\dgs between areas below:
1 N
Cesduirmanies Filters Columns
Y

I

.,

N
- AY
Figis= * Walugs Rows > vWalues

Row Labels ~! Sum of Sales
George Washington 471648
Note: In the data, Tom Jefferson James Madison 720936
appears instead of Thomas Jefferson |john Adams 341352
Thomas Jefferson 302100
|T:::m lefferson | 69900
Grand Total 1905936

Return to the Sales sheet, and select “Column C” by left-clicking on the “C".

A B C D E
1 |Sales Order # \ Salesperson # Salesperson Title \ Regiol
2 87082 1301 George Washington |Sales Associate | South
3 87083 1302 John Adams Senior Sales Associate Northea
4 87084 1304 James Madison Sales Associate | Northea
5 87085 1302 John Adams Senior Sales Associate West
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Visualization Using Tableau

With “Home” selected

Review

"’* E Insert  Page Layout Formulas Data
E;;mt Arial «|12 - AT AT
Col ~
e 6Forpn:’atPaimer B I U~ H-. &vA-
Select “Find & Select” == Clipboard 5 -
0O Search

Conditional Formatas Cell

B B R ey O

Insert Delete Format

Sort & Find &

AN E Formatting ~ Table~ Styles~ v v v & Clear~ Filter v Select ~
nber 5] Styles Cells Editing
and then “Replace”.
L Find. ~
(—Pc Replace... v
- Replace (Ctrl+H)
Com plete the d|a|0g box. Search for text you'd like to change,
11 =] Bl and replace it with something else.
Find what:” Tom Find and Replace .
“Replace with:” Thomas
Select: “Replace All” Fing Replace
Find what: Tom
Replace with: Thomas|
Options ==
Replace All Replace Find all Close
“ ”
Select "OK”. Microsoft Excel X
All done. We made 3 replacements.
“Close” the “Find and Replace” dialog box.
Find and Replace ? X
Find Replace
Find what: Tom w
Replace with: | Thomas 7
Options »»
Replace Find All Eind Mext Close
4
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Visualization Using Tableau

Return to the sheet containing the Pivot Table, and the “Salesperson” field will not be
correctly displayed until the Pivot Table is refreshed.

A
1
P
3 |Row Labels -
4 |George Washington
5 |James Madison
6 |John Adams
7 |Thomas Jefferson
& |Tom Jefferson
9 |Grand Total
Select any cell inside the Pivot Table, for example, cell A5.
Select “Analyze”.
Select “Refresh”.
Select “Refresh All".
e Home Insert  Page layout Formulas  Data Ngaview  View oper . Help  ACROBAT :'Lh.'re Desicn gl
B Artive Fielt e —- Group Selection I b [b\_ 73 [ rietus, trems, & Sets
Tahle | S3lesperson a '-‘E Ungrougp EFin Ra:’fm':ﬂh |’_|‘:-_II'II]E<‘I!.-! Ao | W
x [ Fietd Setngs = - Salrce -
Active Held Group Flter [B Refeesh Calulalivns
Fo | hames Madison B Retresh Al
i b = ? =k & " Refresh All (Ctrl+ Alt+ FS)
(et the 13tact data by refrezhing al
Row Labels -l g
George Washington
James Madison
lohn Adams
Thomas Jefferson

Grand Total

The “Salesperson” field now contains only valid entry data.

Part 1: Clean the Data in Excel using a Pivot Table 5



Visualization Using Tableau

Clean the Data Using a Filter

Continue to verify that the Excel data is consistently recorded LA
. Number Region
before connecting the Excel worksheet to Tableau. For example, 1 Midwest
there are only four valid entries for the field Region. 2 Horheast
4 West

A spelling error or a missed coding in the field, such as “Western”,
must be corrected. The data verification can easily be accomplished by using a Filter.

Return to the “Sales” sheet.

Select Cells “Al” through “11”.

A B £ C E F e H |
1 |Sales Order # Salesperson#|  Salesperson Title Region State|  Product #ofunits |  Sales |
? aropz 1301 George Washinglon Sales Associabe | South S Stuffed Pig 480 512,000.00
3 27083 1302 John Adams Senior Sales Associate Mortheast VT Stuffed Horse 1244 532256.00
4 &/084 1304 James Madison Sales Assaclats | Mortheast MH Stuted Panda G684 51573200
Select: “Data”.
Select: “Filter”.
Ak Fome  Inst Page lapout  Rormualis Doz Revew  viee D i Hdp  &CROEAT S2 Eagrch = S o mint
f L, T [TGseries & Cornectiors - . L =F & & = r
GAR| B 5 o (oD 514 % g3 | o
Bl Fafian ke Seogacks = | T Sl RSN ot Wl 1 P | lim
Lo & &l ) e %E Athereed  Colimm ER 7 Analesk~ SEn -
ELE e Dl Qoo Bdersion Dhla " Szrid N TumToici P
Al [ T a— Fillar (Ckrl- Shitt+ L)
Tom w1 A rering 4or e sedecw
a [0} I 11 e 1 ]
1 [Sales Order # Salesparson #  Salesparson Tit ) sct | #ofunits  Sales |
z 57082 1301 Genrge Washinglon Saks dssoc Q ? T P 480 $712.000.00
ES a3 1302 John Adams Senicr Sales Horse 1,344 532 258.00
L Bra 1304 Jamas Magison Salkes Assoc "arda GE4 515 THE.00
13 BT8R 1302 John Adams Sencr Sales 1Py 1,440 528,500.00
3 BTORE 1302 John Adams Sencr Salgg T iPg 1,224 530,600.00
¥ LY. T 1301 Gearge VWashington Sakes Assaciate | Mornheas:  MJ Stufted Horse 468 511,232.00
Select the dropdown arrow to the right of the field “Reglcy.
isperson . Salesperson | - Title B < State - Prc
1302 John Adams Senior ! 7| sonawz AR Stuffed
1303 Thomas Jefferson Senior: 7| coazima GA Stuff
1304 James Madison Sales A Sort by Color 5 ME Stuffe
1304 James Madison Sales A MT Stuffe
1304 James Madison Sales A IN Stuffi
1302 John Adams Senior OH Stuffe
1304 James Madison Sales A FL Stuffe
1304 James Madison Sales A TotEles ’ cT Stuffe
1303 Thomas Jefferson Senior St B AZ Stuffed
1302 John Adams Senior =l (Select All) NV Stuffe
1304  James Madison Sales A SN MA Stuffes
1302 John Adams Senior ¥ South IN Stuffi
1302 John Adams Seniorg NY Stuffe
1304 James Madison Sales IN Stuffed
1304 James Madison Sales A uT Stuffe
1304 James Madison Sales A WA Stuffed
1301 George Washington Sales A NC Stuffe
1301 George Washington Sales A [Co ] | conca vT Stuffes
A%h% labhe Adamme Caninr b nine ceemmomen IS en Ch kB

Note: “Western” appears in the d ition to “West”.

Select “Cancel”.

Part 1: Clean the Data in Excel using a Filter



Visualization Using Tableau

Select “Column E” by left-clicking on the “E”.

A B C D E
1 |Sales Order # Salesperson # Salesperson - Title ~ Region -
2 87082 1301 George Washington Sales Associate | South
3 87083 1302 John Adams Senior Sales Associate Northeast
4 87084 1304 James Madison Sales Associate | Northeast
5 87085 1302 John Adams Senior Sales Associate West
6 87086 1302 John Adams Senior Sales Associate Northeast
7 87087 1301 George Washington Sales Associate | Northeast
8 87088 1301 George Washington Sales Associate | Northeast
9 87089 1304 James Madison Sales Associate | Northeast
Select “Home” followed by “Find
b In'..'\-'l “mge Lapout Farmniols=s ks o Vi wpzboper Hele ACRTAAT - 2 thare 1 Com
ik BT L BU e E BB K f
e HMru-B-2-A-|SHE==H- $-% 1 R | S e e Ermes | ©- o B | S
bz [ P 4 rr " rarke K e it [ e
£l Fogion LL
& L} 1 I =+ hele
1 |Babes Didder § Balesperson & Saleaperson Tl Region -|  Slale B v
z aToE2 1304 George Washington  Sales A=zsociate | South Stuffed Pig o
3 R ] 1302 John Adams Senior Sales Ansooiate Northeast Stutfed Horse e 156
BT0R4 1304 Jdamas Madisen Balas Arseckati | M HH Bhefted Pancla Loz Faz
o FTOES 1302 ki Aglaime Senior Sales Asnodiile AK Stulled Fig TroikicralPareaien 300
[ ATOEE 1302 uobin Adames Senior Sales Assock Morthesast cT Stuffed Pig P— ing
T aroar 1301 George Washingtan Mortheeast M. Stuffed Horse et tin e atine i
& BTOER 1304 Grorge Washingtar HMertheast ME Stutted Brar S 160
u ATOER 1304 James Masdisen Miirtheenst NY Shuffesl Elophart B senatumea TRR
0 aroan 1301 Sales d=epciie | Hoalheast CT Slulled Horge T Feection Fare HL]
1 AT 1304 JJa Sales Azzociate | Wt CA Stuffed Panda 1478 & 27.040
Select “Replace”.
Complete the dialog box.
Find and Replace ?
Find Replace
Find what: Western
Replace with: | West
Options > >
Replace All Replace Find All Find Mext Close

“Find what:” Western
“Replace with:” West”
Select: “Replace All”

Part 1: Clean the Data in Excel using a Filter

State
MS
VT
NH
AK
CT
NJ
ME
NY



Visualization Using Tableau

Se|eCt “OK". Microsoft Excel x

All done. We made 3 replacements.

“Close” the “Find and Replace” dialog box.

Find and Replace ? X
Find Replace
Find what: Western o
Replace with: | West o
Options ==

Replace All Replace Find All Find Mext

Select the dropdown arrow to the right of the field “Region”.

it 1] i ¥ 1 1 5 1
1 |Sales Qrder ¥ Saluspeison £ Salespersan - Tille - Region Slale - Proaduc] < ol unils
F STDE2 1304 Guopge Washinglen  Sales & 2] sz L5 Slulied Pig 481
1 STOES 1302 Jahn Adums Senior ! f] oy VT SlulTed Hurge 134
4 ETDEd 1304 Jarmes Madi=on Fules E— ¥ WH Siufled Panda 10
. ETOES 1302 Jahn Adams Bemiar ! i3 Slulied Pig 1,141
0 ETOEG 1302 John Adams Herior ! T Stulied Pig 1,228
T ETOET 1304 George Washinglon  Sales & Nd Stuffed Horse d61
u ETUEE 1301 George Washinglon  Sales a0 ! ME Stuffed Bear 1,541
] ETOER 1304 James Madi=on Hales b Faan = WY Stuffed Elephant 4
ETORD 1304 George Washinglon  Sales & — &T Stuffed Horse B
1 ETe 1304 James Madi=on Sales & L Stuffed Panda 140
1z ETOE2 1303 Thomas Jelferson Lemior ! Py Shulfed Lamb a8
1 TS 1304 James Madizon Sales & - W Stuffied Lambs an
i ET{Rd 1304 George Washinglon  Sales & IL Shulfed Lamb 1,18
£ ET{RS 1204 James Madison Sales & HD Stufied Pig ad
B ET{RE 1302 Jaohn Adam=s Leriar ! Rl Stufied Pig Bdl
T ET{ET 1204 James Madi=on Sales A 1] Stufied Pig 1,03

Verify that there are only four regions used.ia-tivedata.

Select “Cancel”. ==

Part 1: Clean the Data in Excel using a Filter



Verify the data in the field Product.

Visualization Using Tableau

A
Product
Stuffed Bear

Stuffed Horse

Stuffed Lamb
s Stuffed Panda
7 | Stuffed Pig

1
2
3 Stuffed Elephant
4
5

Select the dropdown arrow to the right of the field “Products”.

A B C D E F

1 [Sales Order *| Salesperson #. Salesperson . Title .. Region State . =
2 87082 1301 George Washington Sales Associate | South MS 2l

3 87083 1302 John Adams Senior Sales Associate Northeast VT i

4 87084 1304 James Madison Sales Associate | Northeast NH '
5 87085 1302 John Adams Senior Sales Associate West AK

6 87086 1302 John Adams Senior Sales Associate Northeast CcT

7 87087 1301 George Washington Sales Associate | Northeast NJ e :]
8 87088 1301 George Washington Sales Associate | Northeast ME =
9 87089 1304 James Madison Sales Associate | Northeast NY B ontied brnant
10 87090 1301 George Washington Sales Associate | Northeast CT :2::::::“:
1 87091 1304 James Madison Sales Associate | West CA :z:::fs ::""‘
12 87092 1303 Thomas Jefferson Senior Sales Associate Northeast PA
13 87093 1304 James Madison Sales Associate | West WA
14 87094 1301 George Washington Sales Associate | L o

No corrections are needed as the six products

awane

anma

Select “Cancel”.

Select Data > “Filter” to remove the filter.

Sl A mioan

Midwest

[ T R—y

b EEn o PAIa

e data are in the Product table.

File Hame  Irserl Page layosd  Foomulas E Fevipn  Wies  Deeskpa ==l sareh 3 Shane
|y et 1% et sewnnzes v [T Casrse & Canme e . ! E i E= Cmnl T
['_l- e [B taming tonrechars |E: § I -]-td] = \IK = :| ; - m ﬂ
At Fefrash sode Gesarapty S | = on | Ahzr Toqne Wrat H Forccam | Getline
Mt = B F1am Isblstenge Aji B he En:l Aty Tedimiea B9 Anatis imel
o & Trerefnnr. by ruwns N Czrepdione b Tpee, Sret N Filrer oty Tonde Rreme
The last row of data is on line 95. There is a header and 94 rows of data.
A B C D E F
1 Sales Order # Salesperson # Salesperson Title Region State
92 87172 1302 John Adams Senior Sales Associate Midwest SD
93 87173 1304 James Madison Sales Associate | Northeast NJ
94 87174 1304 James Madison Sales Associate | Northeast NY
95 87175 1303 Thomas Jefferson Senior Sales Associate Northeast MA
96

Save, close the file and exit Excel.

Part 1: Clean the Data in Excel using a Filter



Visualization Using Tableau

Part 2: Tableau
Connect the Data.

Open Tableau.

Select Microsoft Excel. ==

2| Tableau - Book1

Fite Data Server Help

Tl Cpen

1= AT
Crganime *

Select the file name. s

A% Crchily 50" bl Brinmbedwe

Mew foider

Ly fuddly Shufted Animakd..

.| o e Lena] W ks

Select “Open”.

Lisccian &

X
I hample w [ Eearch ) Sample &=
- m 8
Dhabez mncfifiend Tr Siee
TARBPO 1T P Wirnss) Cecel A2 EQ KN

suthors O Mark E Frizdman - Dzt modfed 1171820280 191 P4

spa: S8 KL Lorkart hpe  Appicatenimc e o at-ot

e

Filiz nzinic: :.d!',' B v | |Eszol Workbooks (ab take
Oy Canead

Double click on the sheet “Sales” that
contains the data.

Part 2: Tableau — Connecting to Excel

Connections Add

Cuddly_Stuffed_Animals

Microsoft Excel

Sheets o

Cleaned with Data Interpreter
Data Interpreter removed some
data. Review the results. (To
undo changes, clear the check
box.)

B Introduction

B Products

I B Sales I

B Salesperson

B Source Data

b |ntroduction A6:C15

10



The 94 rows are connected.

Visualization Using Tableau

—
M = Sortfelks Datasource orgar - Showe aliases I Shoe bidden licids 24 ru:r.-.\I
+ + e A ™ 1 dk: “ ke
Sukes Oroker & Sabisparaoi & Salesparsan Tl Rapien State Product # 0 Unita Sales {Sals)

BTAEZ 1301 &monge Washing Eales Azsnoane| Sourth RS Stuffes Fig 420 12,360

G703 L1302 Jubr Adams Senivr Sples sy, Moe Ll wT SlulTes Hurss 1544 32,256

BsaEs 203 James Fixdizon Lales Azsooatel Mozt MH Stuttec Farnda (=0 15,032

R7T.QER A1F Iehn Adams Ranice Ralns Ass WiRsT AE Araffien Fig 1,740 RGO

G706 2312 Johnfdams Cepicr Seles Ass.. Mociisszh T Stuffec Fig 1224 30,500

Part 2: Tableau — Connecting to Excel
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Visualization Using Tableau

Prepare a visualization of the “Number of Units Sold by Region”.

Double click on “Sheet 17, and rename it “Graph 1”.

' x| 87,088 1,301 G Wa:
1l Go to Worksheet . , eorge Wa

N ) 87.089 1.304 James Mad

B Data Source Sheet1 QNERE:E-RIRN

8 Data Source Graphl [} H O

Select “Region”, and drag it to “Rows”.

il Columns
Data Analytics o [ Fames
¥ Rows - = 4 Region
y o= . - =
Filters -
Tables " Gf’a{]h 1
v Product - -
- I - - Region
# Balesperson Midwest Abc
& State ke Northeast Abc
v it F
South Abc

wae emesye Maros =
b &0f Units [T Automatic > West Abc
+ Sales [Sales)

Lo - Ll £ <=1

Part 2: Tableau — Graph 1, Pie Graph



Visualization Using Tableau

Select “# of Units”, and drag it to the “Abc” column.

Data Analylics Pages jil Columns
 Sss Gy S . = o
Sezrch T I™ 7| Filters
Tablas Graph 1
sw Product Reglon ___
Midwest = Show Me
are Hiepion - o pigmer®? BhE
A= Salespersan ’ ’¢‘Sﬂuth Abt
& Stale [T famomasic ’f" West Abc
-
ae Title -
(1) F
H T
ae Megsure Names |1§’ﬁ, &
selor Size Text
gl
+ Hales {Sales) oBo L
# Sales Order # L2E UEZET
AT SSEEE L SRS T AR I e N R - B & Stanclars = Show Me
Pages Il Coumns o e
13 H ” Oy i
Select “Pie Graph”. e = e B
it
He Graph 1 — |
Region —
Midwest 14 520 = | lthy
ks Hirtheast 265 304
3 Suath 1 420 [l BOF
ETr - West  1636@ M= CFE
- & @
b Size Tast
als 0
Giaisdi | [ Tuaiip

Change the “Fit” to “Entire View".
sk -+ : £

Standard -
Il Columns Standard
= Rows Fit Width
. Fit Height
Graph 1 Entire View

Part 2: Tableau — Graph 1, Pie Graph

Garah 1

il

Fia pie charls Ly
Ler o QST
1oe2 QEEEED

13



Visualization Using Tableau

Drag “Region” to “Label”.

o€ > R 8 -0 W@ -
Data Aralytics *
Pages il Calemns
Fa Sales (Cuddly_Stutfed_A...
2 Rows
Saarch o5 m .
Filters
Tables Gra ph 1
ton - Proguck
oRegion
N
fac BalELperson ﬂ"{"“
& State ™ o )
Midwest
wm Tibla . West
W fdemrnre Mo D::\r Siem Lobel
#4800 Unils = ] ]
+ EBales (Saks) D";;I T:’ﬁ =
= Sales Oroer # ootip || Amge |
[T}
t  Salcsporson # "m
D Fafilhe {preneraled) L= M
O Lomgiie (generstec) [3 U Of Unit. ot
. ou
+  Sales (Cowd)
+  Mrasure Values
Mortheast
Drag “# of Units” to “Label”.
— Solm. .p;:;m .i.l.l.l T
= R
Tables e i
Tillers i e
A Froduet el — Midwest
arc Region 14 B20
Ak Salesperson
& State Pelzrhz
ac Tithe

abr  LAEASLE AArEs

+ R —
# Sales (Sakes) i !.3,, :.;,
#  Eales Order ff :;
# Salesperson # BY sunizorune.,
@ Lafiude (penerated) & Ui o une.
& Longitude (generated) &Y Fegon
% Sales (Count)

# Messure Valkmes

Sowith
15,720

Maortheast
36,384

Now it is easy to visualize that Northeast sold the most units, 36,384, and that Midwest

sold the least number, 14,820.

Part 2: Tableau — Graph 1, Pie Graph
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Visualization Using Tableau

Filters G ra Dh 1

Double click on the Title of the graph, “Graph 1”, and change it to “Number of Units Sold
by Region”. Do NOT change the Sheet Name on the tab.

| Edit Title s

ableat, Liht v s il ] .- it = || K Edit Title X

= Sheat Ma

[esheet Name> B [ z][u](me-[=]= =] [men-]|[x

Number of Units Sold by Regicn
Fazzt Caraal Aopy
Reset a oK Cancel Apply

Select OK. =

Graph 1 is now completed.

Part 2: Tableau — Graph 1, Pie Graph 15



Visualization Using Tableau

Preparing a visualization of the “Sales by Region”.

Click on new worksheet, and rename “Sheet 2" as “Graph 2”.

U Dara source wrapnl oy | oo U
B Data Source Graph1 | Sheet2 | [
B Data Source Graphl Graph2

Select “Region”, and drag it to “Rows”.

iii Columns
Data Analytics o [ Fames
A Sales (Cuddly_ Sluffed & = Rows P ¢ Region
o | —’—’
&7 E - -
Filters - =
Tables e Gr’aph ]
v Product _’———
- CE N - - Region
we Splasperson Midwest Abc
& State Marks MNortheast Abc
v it f
South Abc
wae Memoaye Moo b
b &0 Units [F] Automatic - West Abc
+ Sales [Sales)
Lo - Ll £ <=1

Part 2: Tableau — Graph 2, Vertical Bar Graph



Visualization Using Tableau

Select “Sales”, and drag it to the “Abc” column.

Data Analylics Pages jil Columns
garch PT™ | Filters
Graph 1
Tables
Reqgian
e Froduct Midwest "= Show Me
A Region Nortpef®t BhE
Abe Salesperson Marks ,ﬂﬁ[h abe
& Stats [7] Aatomasic ’ﬁ’ West Abc
) -
14 ’
ake Tithe :: ’& I-_I_I
ate Measure Names w Size Tet
# #01Units i1
«CECE—_— | | &
. i Deta Teoltiz
# BGales Ordar #f L
it Salesperson #
& Latitude (genarstad)
& L orglude (peneraled)
#  Sales (Cowd)
# Measure Vales
Select the Horizontal Bar Graph.
lii Columns
= Rows Region -
Graph 2
Region —
Midwest 341,700 =L
Mortheast 822 756
South 352,752 [ L5
West 388,728 .-

Part 2: Tableau — Graph 2, Vertical Bar Graph

e (R
‘Q‘
l.l.
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Visualization Using Tableau

Qrapn g
Reyion
ey ]
pegece® |
gy |
west | I
] 3 K 108 g 2I0K 2R HIEIK =2l LlOK Lu 10K 25K B £inOF FLEIE Eptin] HIKIK H L0

Sales (tales)

Select the “Fit” dialog box, and select “Fit Height".

i O I ™ (N - S 7 FEES R AT S I £ +# |[Stunded - i -

Data Anahtics * Papes il Crlumns
(79 Satles (Cuddly_Slu... = Raws
ek
w21

" L o " o L = L " L3 o g LA S -
EI T Ty
“ ” H 1] ”
Select “Sales”, and drag it to “Label”.

# | € + 0 B G- R A eI
Data  Aenalylive Tages 1 ol
EL Sales Cutdhy_ShuL.. = frume
war AT = || Filers
Tablas

Begion
= Product
*= Hegian harks
die Cusbergprer wony
& statn ol Muineastc - Midwess dit
= TiHiE = &
s Mearovs Wamer e iz m
L X Lnits ‘r”‘ o
- EEEEIDT s | T
= Gales Order i i
= Calbwper s ¥ = Horteast
T L alke (ol ATy
B Lo s (EaeTane. .
e {Ueu)

L Mo Kooy
S EERY]

Part 2: Tableau — Graph 2, Vertical Bar Graph 18



Visualization Using Tableau

Add dollar signs to the labels by clicking on the drop-down on the right side of

“Sum(Sales(Sales))".

Select “Format”.

Click on the drop down on the right side of “Default”, “Numbers”.

Tables
T

¥ e

mo AT fdamer

+ % B d += % + =+

Arpalylics

wCaikdly Kl

Hogian

St

Hiters

[

B ko

S0 Unks
Timleg i Saale}
Sales Order e
Selrapiir e #
Labtucis (panensie Filter...
et st
Saves oy Show Filter
A Fanaes
Farmat...
= Inoluge m 1oomp :
Dimension
Attribute
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Visualization Using Tableau

Select Currency (Custom), and change the number of decimal places to 0 decimal

places.

Close the Format window by clicking on the “x”.

Part 2: Tableau — Graph 2, Vertical Bar Graph
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Visualization Using Tableau

Graph 2

Regian

2491400

$357 737

2a4ath

b EIC

Lok UGk 10 2004, PO 300% o A0 UK SO0 JUIK bk LT 4 FILR L BULK BLOH
Lales (Sales)

Now it is easier to visualize, Northeast had the highest sales, $822,756, and Midwest
the lowest, $341,700.
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Visualization Using Tableau

The graph may look better if flipped. Select “Swap Rows and Columns”.
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Visualization Using Tableau

Double click on the Title of the graph, “Graph 2”, and change it to “Sales by Region”. Do
NOT change the Sheet Name on the tab.

Edit Title = Cdit Tile *

Tabileat Liht v a5 o |fe ] .- et || 3 Tableau Ligk: w15 ~[[e [x IJ|-"E! 3| (e |
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You must try different alternatives until you find a visualization that clearly
communicates the story.
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Visualization Using Tableau

Prepare a visualization by adding “Product” to the graph.

The visualization “Sales by Region” is a great place to start. Select “Duplicate”.

# | & 2> b g 8- fol -GSl g - | B3 I& IF | £ - E # | Fit
Data Analytics * | Pages Duplicate §ili Columns SUM(Sales (Sales))

A duplicate worksheet Titled “Graph 2 (2)” is created.

8 Data Source Graphl Graph2 Graph2(2) [4 H I
Rename the new worksheet “Graph 3.
8 Data Source Graphl Graph2 Graph3 [ B 0

Select “Product”, and drag it to the right of “Region” in the “Columns”.
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Visualization Using Tableau

That looks very busy, so switch the “Row” and “Columns”.
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Visualization Using Tableau

Change the visualization to “Region” within “Product”, by dragging “Product” to the left
of “Region” on the “Rows”.

iii Columns SUM(Sales (Sales))

Columns SUM(Sales (Sales))

rows (T D T )

v--—-—--—_—’

Product  Region

stuffed  Northeast | 150,240
B o | 2,000
west [ $11.280
stufed  Midwest | NN ;- 5cc
Elephant o rtheast [N $22.53>
south [N 525.564
wes: | |51 735
stuffed  Midwest || $17.568
Horse  northeast [ 5150.912
souen N <
wese [ 535,712
Surred wicwes: | 59,752
Lo ortness: N § 135,525
souen | |::.755
wes: | 39,515
stuffed  Midwest || $17.112
Panda  nortneast | 0. 144
soucn | 02 52

Stuffed
Pig

Midwest $149,700

Northeast $205,800
South
West $105,600

10K 20K 30K 40K 50K 60K 70K 80K 90K 100K 110K 120K 130K 140K 150K 160K 170K 180K 190K 200K 210K 220K

CQales (Sales)

The Sales are thus presented alphabetically by “Region” within “Product”.
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Visualization Using Tableau

Select “Sort Ascending”.

4 Tl W Ay - | R £ - [E # FiHeight - qal - T

Data

Soriest ascanding by sum of Sales (Sales) within Product
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st | 5.3+

Northezs+ N 150,912
west | NG 5390516

st | o:.795
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Midwest || NN $17.112

viest [ o554

st | 502,543

Northezs+ N 150,144
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e I 105,500

waictvvest |, 5149.700
orthe+ | 205,800

OK 10K 20K 30K 40K 50K 60K 70K 80K 90K 100K 110K 120K 130K 140K 150K 160K 170K 180K 190K 200K 210K 220K

Now it is easier to visualize: the Stuffed Pig had the highest sales in dollars in the
Northeast and the lowest in the South region.

Double click on the title, and change “Sales by Region” to “Sales by Product within
Region” and select “OK”. Do NOT change the Sheet Name on the tab.

Edit Title:
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Edit Title >
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Visualization Using Tableau

Prepare a visualization of the “Sales by State”.

Select “New Worksheet”, and rename the sheet “Graph 4”.

8 Data Source Graphl Graph2 Graph3 | [ B I
B Data Source Graphl Graph2 Graph3 Sheet4 [}
B Data Source Graphl Graph2 Graph3 Graph4 [

Drag “State” to “Rows”.
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Select the “Filled Map” from the “Show Me” section.
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Visualization Using Tableau

Drag “Sales” to “Colors”.
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Visualization Using Tableau

Click on Alaska and select “Exclude”.

v KeepOnly X Exclude @ ©

State: AK
Sales (Sales): 28,500

When you hover over the darkest-colored state, you will observe that CT has the most
sales.

- i SCMrSales (Eakesl
Graph 4 3ales (Sakst)

|
i [ £.400 155 554

AT

State: CT
Sales (Sales): 168,924
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Visualization Using Tableau

Let us look at the alternative map.
Select “Symbol Map”.
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Move the indicator to the right to make the circles larger.
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Visualization Using Tableau

This is a meaningful visualization.
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Double click on the Title of the graph and change it to “Sales by States”, and select OK.
Do NOT change the Sheet Name on the tab.
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Visualization Using Tableau

Create a “Dashboard”.

Select “New Dashboard”.
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Visualization Using Tableau

Drag “Graph 1” into the “Dashboard”.
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Visualization Using Tableau

Size Graph 2

Number of Units Sold by Region

Midwest
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West
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Drag “Graph 3” into the dashboard under “Graph 1" and size “Graph 3”
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Visualization Using Tableau

Drag “Graph 4” into the dashboard to the right of “Graph 3" and size “Graph 4.
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Visualization Using Tableau

The Dashboard is completed

Region
West Midwest 2827 755
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Select File>Save As
File name: | Cuddly Stufled_Amimals -
Save as type: | Tableaw Workbook (= twh) -

Tableau Workbook [*.twhb)

Tableau Packaged Workbook [* twh)

s Hide Folders Cancel

Save As a Tableau Packaged Workbook (*.twbx) so that the data is connected to the
Tableau Visualization.
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